MICROSOFT EXCEL XP

NEW FEATURES
COPYRIGHT & TRADEMARKS

Copyright © 1995-2000 by PTS Learning Systems. All rights reserved. Information in this document is subject to change without notice and does not represent a commitment on the part of PTS Learning Systems.

Trademarked names appear throughout this book. Rather than list the names and entities that own the trademarks or insert a trademark symbol with each mention of the trademark name, PTS Learning Systems states that it is using the names for editorial purposes and to the benefit of the trademark owner with no intention of infringing upon the trademark.
NEW FEATURES

COPYRIGHT & TRADEMARKS ........................................................................................................... II

LESSON 1 - GETTING STARTED ......................................................................................................... 1
      Working with Excel 2002 ............................................................................................................. 1
      Using the Task Pane .................................................................................................................... 2

LESSON 2 - USING NEW FILE FEATURES ........................................................................................ 3
      Using the Open Dialog Box ........................................................................................................... 3
      Using the My Places Bar in the Open Dialog Box ........................................................................ 4
      Using the New Workbook Task Pane ........................................................................................... 5
      Using a Template .......................................................................................................................... 6
      Using the Basic Search Task Pane ................................................................................................ 7
      Using the Document Recovery Pane ............................................................................................ 8
      Creating Adobe PDF Files ........................................................................................................... 9

LESSON 3 - USING NEW WORKSHEET FEATURES ..................................................................... 11
      Using the Scroll Bar Shortcut Menu ............................................................................................. 11
      Using the Paste Options Button .................................................................................................. 11
      Using the Paste List ..................................................................................................................... 12
      Pasting from the Clipboard Task Pane .......................................................................................... 13
      Using the Auto Fill Feature .......................................................................................................... 15
      Working with the Options Dialog Box .......................................................................................... 16

LESSON 4 - USING NEW FORMATTING FEATURES ................................................................... 17
      Using the Insert Options Button ................................................................................................... 17
      Splitting Cells ................................................................................................................................ 18
      Drawing Cell Borders ................................................................................................................... 18
      Using Distributed Alignment ....................................................................................................... 19
      Pasting Formats ............................................................................................................................ 20
      Extending List Formats and Formulas ......................................................................................... 21
      Coloring Worksheet Tabs ............................................................................................................. 22

LESSON 5 - WORKING WITH FORMULAS AND FUNCTIONS ....................................................... 23
      Entering Formulas ......................................................................................................................... 23
      Using the AutoSum List ................................................................................................................ 23
WORKING WITH EXCEL 2002

Discussion

Excel 2002 includes an assortment of new features.

When upgrading from Excel 97, the first feature you notice is the new interface. The Excel 2002 interface has a new look and feel. To the right of the worksheet area is the task pane. The New Workbook task pane provides links for opening new or existing workbooks.

You can also ask the Office Assistant for help by typing a question in the Ask a Question box at the far right of the menu bar. This feature provides a fast, always-visible method of getting help.

Excel 2002 now includes an Office Clipboard that can hold multiple items. You no longer have to complete the copy and paste operation before copying another item. As you copy items, they appear on the Clipboard task pane. You can gather multiple selections and then paste them as desired.

When working with multiple workbooks, the taskbar displays a button for each open workbook, simplifying the task of switching between open workbooks. The Search task pane is also available to perform simple or advanced file searches. New worksheet features include the ability to color worksheet tabs, enhanced worksheet protection features, and the ability to find and replace cell formats.

Excel 2002 has added several features that make it easier to work with formulas and functions. The AutoSum button now provides a list with the most commonly used functions, such as Average, Max, and Min. Inserting and editing functions has become a much more intuitive process. You can easily identify and correct errors in calculations in a single cell or check errors in the entire worksheet. The Evaluate Formula tool lets you observe the expressions in a formula before and after they are calculated, and the Watch Window allows you to view a range of cells containing formulas in one convenient location.

The Paste Options button allows you to decide how formatting differences should be applied to pasted cells. It also allows you to link pasted data to its source cell. You can also use the Paste list to select other options for pasting text and formulas.

New graphical enhancements allow you to insert and format preset diagrams into a worksheet. The Insert Clip Art task pane provides numerous categories of clip art and AutoShapes that can also be inserted into a worksheet.

Increased Web features have been added to Excel 2002. You can easily preview how a worksheet will appear on the Web. The procedures to create and edit hyperlinks and to publish a workbook as a Web page have been enhanced.

Excel 2002 now provides many new features for reviewing and sharing workbooks. Additionally, you can easily import and export data from other applications or from a Web page. New PivotTable
features include creating PivotTable reports by dragging fields into a blank PivotTable report, hiding field items, creating PivotChart reports, and creating interactive PivotTable lists for the Web.

**USING THE TASK PANE**

**Discussion**

The task pane provides links to many common tasks in Excel. For example, you can use the task pane to create a new, blank workbook or to reopen a recently modified one. The task pane is actually comprised of several task panes, which can be viewed using the Other Task Panes list. The name of the current task pane appears in the task pane title bar. You can use the other task panes to find and insert clip art, search for files, and create and apply styles.

The Back and Forward buttons located in the task pane title bar navigate to previously viewed task panes. Blue text in the task pane indicates a link to an action or dialog box.

You can hide or display the task pane according to your needs. Although the features in the task pane are useful, you may want to hide it to display a larger worksheet area. By default, the task pane appears each time you start Excel. You can disable this feature by deselecting the Show at startup option at the bottom of the New Workbook task pane.

| ![Information icon] | Each task pane can be opened with a separate menu command. The Task Pane command on the View menu opens the most recently used task pane. |
| ![Information icon] | The task pane is also accessible from the toolbar shortcut menu. |
| ![Information icon] | You can change the size of the task pane by dragging the splitter bar (the border between the vertical scroll bar and the task pane) as needed. |

**Procedures**

1. To view a different task pane, select the Other Task Panes list on the task pane title bar.
2. Select the desired task pane.
3. Click the Back or Forward button to return to a previous task pane.
4. To close the task pane, click the Close button in the upper, right corner of the task pane.
5. To open the task pane, select the View menu.
6. Select the Task Pane command.
USING THE OPEN DIALOG BOX

Discussion

The most significant change in the Open dialog box is that it is now a resizable window. Other changes include the Places Bar, which appears on the left side of the dialog box. The Places Bar provides shortcuts to various folders containing commonly used files, as well as desktop options and recently opened files.

The Views button at the top of the Open dialog box allows you to select one of eight views: Large Icons, Small Icons, List, Details, Properties, Preview, Thumbnails, or WebView. The Thumbnail view displays a miniature image of supported graphic and HTML files. You can change views using the Views list or by repeatedly clicking the Views button to cycle through the different views.

The Open button now provides a list of options that allow you to open a workbook as read-only, open a copy of a workbook, open an HTML file in your browser, or open and repair a damaged file.

You can also access the Open dialog box by selecting the More workbooks link in the New Workbook task pane.

If you use the Favorites folder to quickly locate files, you can open it using the Favorites icon on the Places Bar. You can access the Add to Favorites command from the Tools menu in the Open dialog box.

Procedures

1. Click the Open button on the Standard toolbar.
2. Select the Look in list.
3. Select the drive where the workbook you want to open is located.
4. Open the folder in which the workbook you want to open is located.
5. Click the arrow on the Views button.
6. Select the desired view.

7. Select the name of the workbook you want to open.

8. Select the **Open** list.

9. Select the desired option.

---

**USING THE MY PLACES BAR IN THE OPEN DIALOG BOX**

**Discussion**

When in the Open dialog box, you may notice a bar containing icons on the left-hand side of the window. This is called the **My Places Bar**. The My Places Bar contains shortcuts to commonly-used folders, such as **My Documents, My Network Places, Favorites and History**, the latter of which is a history of the last places that you went to open or save a file.

You can add items to the My Places Bar, such as a shortcut to your A: and D: drives or to one or more of your mapped network drives (such as M:, H: or S:).

You can also remove items from the My Places Bar if you don’t use them.

Finally, if you add too many items to the My Places Bar and it becomes overcrowded, you can tell the program to show the items as Small Icons so that you can see all of them at once. You can even move items around on the My Places Bar.
Procedures

1. Click Open from the File menu (or click More Documents from the New Document Task Pane).

2. To add a folder to the My Places Bar, navigate to that folder and select the folder. Then click the Tools button on the toolbar to the right of the Look in box. Select Add to “My Places.” The folder will be added to the My Places bar.

3. To add a drive to the My Places Bar, click on the drop-down arrow next to the Look in box and select My Computer. Click once on the drive that you want to add and then click the Tools button on the toolbar to the right of the Look in box. Select Add to “My Places.” The drive will be added to the My Places bar.

4. To make the icons on the My Places Bar smaller, right-click on the My Places bar and select Small Icons. To return to large icons, right-click on the My Places Bar and select Large Icons.

5. To delete an item from the My Places Bar, right-click on the item and select Remove.

6. To rename an item on the My Places Bar, right-click on the item and select Rename. Type the new name and hit enter.

7. To move and item up or down on the My Places Bar, right-click on that item and select either Move Up or Move Down.

USING THE NEW WORKBOOK TASK PANE

Discussion

Excel 2002 opens to a new, blank workbook and the New Workbook task pane in the application window. The New Workbook task pane contains four sections; Open a workbook, New, New from existing workbook, and New from template. Links appear under each section to create a new, blank workbook, create a new workbook from an existing workbook, open a recently opened workbook, and create a workbook from a template.

- Deselecting the Show at startup option at the bottom of the New Workbook task pane disables the task pane so that it does not automatically appear when you open Excel.

- Excel displays the names of the nine most recently opened workbooks at the bottom of the File menu and in the Open a workbook list at the top of the New Workbook task pane. You can use the General page in the Options dialog box to change the number of workbooks that appear in the list.
Clicking the **New** button on the **Standard** toolbar opens a new workbook and bypasses the **New Workbook** task pane. You can also create a new, blank workbook by clicking the **Blank Workbook** link in the **New Workbook** task pane.

**Procedures**

1. Select the **File** menu.
2. Select the **New** command.
3. Select the desired link.

**USING A TEMPLATE**

**Discussion**

You can access one of Excel’s preformatted templates (such as expense reports, sales invoices, or purchase orders) or one that you have created yourself by using one of the template links in the **New Workbook** task pane. This task pane includes links to locally stored templates accessed from the Templates dialog box, previously used templates, templates stored on a web site, and templates available at Microsoft’s Web site.

**Procedures**

1. Select the **File** menu.
2. Select the **New** command.
3. Select the desired link under **New from template** on the **New Workbook** task pane.
4. Select the desired tab.
5. Select the desired template.
6. Select OK.

**USING THE BASIC SEARCH TASK PANE**

**Discussion**

Excel includes a Search task pane that you can use to locate files. The Search task pane actually involves three separate task panes; the Basic Search task pane, the Advanced Search task pane, and the Search Results task pane.

If you are unsure of the file name of a workbook or do not know where the workbook is located, you can use the Basic Search task pane to locate it. When you enter text into the Search text box, Excel searches for those characters in file names, worksheet cells, and text fields in the various Properties dialog boxes.

You can expand or limit a search using the location and file type options under the Other Search Options area. You can search every available folder by selecting Everywhere from the Search in list and Everything from the Results should be list. Conversely, you can limit a search to specific folders or file types using the corresponding options.

When a search is performed, Excel displays the found files on the Search Results task pane. You can click the Stop button at the bottom of the task pane at any time to stop a search. The search is complete when the Stop button changes to Modify. If the file for which you are looking is not found, you can use the Modify button to modify the search or to create a new one.

Pointing to a file name in the Search Results list displays a ScreenTip, which lists the file properties. Clicking the file name opens it in Excel. A list of options appears when you right-click a file name in the Search Results task pane or click its drop-down arrow. These options include opening the file, opening a copy of the file with a new name, copying a file link to the Clipboard, or opening the file’s Properties dialog box.

Your search text is saved in the Search task pane for the entire Excel session; but it is cleared when you exit Excel. However, your selections under Other Search Options are permanently saved until you manually change them.

You can use the Search button on the Standard toolbar to display and hide the Search task pane. If the task pane is already displayed, you can select the Search task pane from the drop-down list in the task pane title bar.

You can also perform a basic search from the Open dialog box by selecting the Tools menu, the Search command, and the Basic Search tab.
Procedures

1. Click the Search button on the Standard toolbar.
2. Select the Basic Search hyperlink at the bottom of the task pane, if necessary.
3. Select the Search text box.
4. Type the text you want to find.
5. To modify where to search, click the Search in arrow.
6. Click the plus sign next to the location you want to expand.
7. Continue expanding locations, as desired.
8. Deselect the check boxes of the folders you do not want to search.
9. Select the check boxes of the folders you want to search.
10. Press [Esc].
11. To modify what to search, click the Results should be arrow.
12. Select or deselect the check boxes of the file types you want to include or exclude from the search.
13. Press [Esc].

Using the Document Recovery Pane

Discussion

Office XP provides a file recovery feature that can recover data lost when an error prevents the normal saving and closing of a file (such as when your computer suddenly crashes or loses power). The next time you start Excel after a system halt, the Document Recovery pane appears on the left side of the application window, with a list of all workbooks that were open when the error occurred. For each workbook, the task pane shows the file name and when you last saved the workbook. If the workbook is marked as recovered, it is probably a more recent version of the original workbook than the last saved version.

Right-clicking a workbook in the Document Recovery pane displays a list of available recovery options. The Open option opens the recovered file. The Save As option allows you to save the recovered file with a new name. If you save the file with the same name, the original file is overwritten. If the workbook is marked as recovered, you can select the Delete option to delete the recovered file or the Show Repairs option to view the repairs that were made to the file.
You can also open a file by clicking it in the **Document Recovery** pane.

### Procedures

1. Start your computer, if necessary.
2. Open Excel.
3. Right-click the workbook you want to recover in the **Document Recovery** pane.
4. Select the desired recovery option.

---

### Creating Adobe PDF Files

#### Discussion

Your new computer has the Adobe Acrobat 5.0 program installed on it, giving you the ability to create Adobe pdf files via Microsoft Excel, Word, PowerPoint, etc. A benefit of creating a pdf file is that the program takes something like a “picture” of the spreadsheet on your screen so that you can share it with others without requiring them to have MS Excel on their computer. All they need to view your pdf file is the Adobe Acrobat Reader, which is a free program that can be downloaded from the Adobe website at www.adobe.com.

Another benefit of creating pdf files is that the file you create will look exactly as you created it on anyone’s machine, regardless of the configuration of the viewer’s computer. This is useful when you are sharing files with those who have different versions of Excel or different printers than you do, both of which may change the formatting of your document and make it look different than when you created it. With pdf files, what they see is what you see.

Adobe pdf files are created within the software program that you created the file in. In other words, if you want to make a pdf file out of a Excel document, you should do it from within MS Excel.

#### Procedures

1. Create the Excel document and save it.
2. Click the **Print** icon on the Standard Toolbar (or select **File, Print**).
3. Change the printer **Name** to the **Acrobat Distiller** (NOT the Acrobat PDFWriter).
4. Click **OK**. If you had not saved the document, you will be asked to.
5. You will be asked what you want to name the pdf file and where you want it to be saved. Name the file and select a location (My Documents is NOT the default location for pdf files, so select My Documents).

6. Adobe Acrobat may take a few moments to open up, but you will see it open up on the Taskbar. You can click on the Adobe program on the Taskbar, but you must wait for the file to finish being created.

7. Once the pdf file is created, it will appear within the Adobe Acrobat program for you to view. There is no need to save the file. You can simply close it. It has already been saved in the location that you selected during the creation of the file.
LESSON 3 -
USING NEW WORKSHEET FEATURES

USING THE SCROLL BAR SHORTCUT MENU

Discussion

The horizontal and vertical scroll bars now provide shortcut menus, which allow you to scroll the worksheet. For example, the Top command on the vertical scroll bar shortcut menu scrolls the screen to row 1. Likewise, the Left Edge command on the horizontal scroll bar shortcut menu scrolls the screen to display column A.

The length of the vertical scroll bar is relative to the number of rows containing data and the horizontal scroll bar is relative to the number of columns containing data. You can scroll to an area of the worksheet by right-clicking the corresponding position in the scroll bar and then selecting the Scroll Here command, which appears on both shortcut menus. For example, if you right-click at the lower end of the vertical scroll bar and select the Scroll Here command, the worksheet scrolls to display the last row of the worksheet. Selecting the Scroll Here command at the middle of the horizontal or vertical scroll bar, scrolls horizontally or vertically to the corresponding midpoint in the worksheet.

Procedures

1. To scroll to a position relative to a scroll bar, right-click that position in either scroll bar.
2. Select the Scroll Here command.
3. To scroll vertically, right-click anywhere in the vertical scroll bar.
4. Select the desired command.
5. To scroll horizontally, right-click anywhere in the horizontal scroll bar.
6. Select the desired command.

USING THE PASTE OPTIONS BUTTON

Discussion

After you have pasted a cut or copied item, the Paste Options button appears adjacent to the pasted cell or range of cells. Paste options allow you to decide how formatting differences should be applied to the pasted cells. They also allow you to link pasted data to its original cut or copied cells.
The available commands are determined by the data being pasted. When copying formatted text, you can select the Keep Source Formatting option to paste the text with its original formatting. When the Match Destination Formatting option is selected, the formatting in the paste location is applied to the pasted text. When pasting numeric data or a copied formula, you have additional options, such as pasting both values and source formatting, formatting only, or values only.

You can hide the Paste Options button by pressing the [Esc] key.

- The Paste Options button can be turned off by selecting the Tools menu and the Options command. In the Option dialog box, select the Edit page and then deselect the Show Paste Options buttons option.
- Many of the options on the Paste Options list are also available in the Paste Special dialog box.

**Procedures**

1. Select the cell(s) you want to move or copy.
2. Cut or copy the cells as desired.
3. Select the cell into which you want to paste the cut or copied data.
4. Click the Paste button.
5. Click the Paste Options button.
6. Select the desired option.
7. To hide the Paste Options button, press [Esc].

**USING THE PASTE LIST**

**Discussion**

When you copy text, numbers, or formulas, you can use the Paste button to paste the data into a new location. However, you can also use the Paste list to select other options for pasting text and formulas.

Formulas is the default command for the Paste button. Unless you select a different paste option, formulas are pasted into the new location and, if the referenced data is also copied, cell references are changed.
You can use the Values command to paste the results of a formula rather than the formula itself. This is useful if you want to paste just the current value of a formula and do not want the pasted data to be affected by changes made to the original cell references.

The No Borders command allows you to copy a cell that has borders and paste its contents without the borders.

The Transpose command is used to switch a vertical range of cells to a horizontal range or visa versa. For example, you can copy the row headings in column A and transpose them to create column headings across row 15.

The Paste Link command pastes a link to the copied cell. If you paste cell B9 into cell D15 and select the Paste Link option, for example, Excel pastes the link =$BS9 into cell D15. Thereafter, cell D15 will always display the same value as cell B9.

Procedures

1. Select the cells you want to cut or copy.
2. Cut or copy the data as desired.
3. Select the cell or range into which you want to paste the cut or copied contents.
4. Click the arrow on the Paste button.
5. Select the desired option.

PASTING FROM THE CLIPBOARD TASK PANE

Discussion

The Office Clipboard stores multiple items (including graphics) cut or copied from various worksheets or other Windows programs. You can then paste the cut or copied items into one or more worksheets or to other Office files.

The Office Clipboard is accessed by opening the Clipboard task pane. When you first open the Clipboard task pane, the last item cut or copied to the Windows Clipboard is displayed. As you continue to cut or copy items, they are collected on the Clipboard task pane and remain available to all Office products.
For each of the cut or copied items, the **Clipboard** task pane displays an icon and a portion of the cut or copied text, if applicable. You can click any item to paste it at the insertion point, or you can use the **Paste All** button to paste all cut or copied items at one time. Right-clicking any item displays a shortcut menu that provides options for pasting or deleting the item.

After pasting text, the **Paste Options** button appears in the worksheet, allowing you to control the formatting of the pasted item.

Once you have finished a particular copying sequence, you can clear the Office Clipboard of all items by clicking the **Clear All** button in the **Clipboard** task pane. In addition, the Office Clipboard clears automatically when you close all Office programs.

You can continue pasting text or numbers to different locations by clicking the item in the **Clipboard** task pane. However, formulas are not copied to the Office Clipboard; only the result of the formula is copied. Therefore, if you use the **Clipboard** task pane to paste a copied formula, only its result (value) is pasted into the destination cell, not the formula itself.

If another task pane is open, you can display the **Clipboard** task pane by selecting the **Clipboard** command from the task pane drop-down list.

You can also open the **Clipboard** task pane by pressing **[Ctrl+C]** twice, since the **Clipboard** task pane opens automatically as soon as a second item is cut or copied.

### Procedures

1. Select the **Edit** menu.
2. Select the **Office Clipboard** command.
3. To clear all items from the Office **Clipboard**, click the **Clear All** button in the **Clipboard** task pane.
4. Cut or copy the items you want to paste.
5. Select the cell into which you want to paste a cut or copied item.
6. Click the item in the **Clipboard** task pane that you want to paste.
7. To paste all the items in the **Clipboard** task pane, click the **Paste All** button.
8. To remove an item from the Clipboard, right-click it in the **Clipboard** task pane.
9. Select the **Delete** command.
USING THE AUTO FILL FEATURE

Discussion

You can use the **Auto Fill** feature in Excel to create a series of labels in a worksheet. Examples of standard series built into Excel include months of the year, days of the week, and quarters of the year.

When you select a cell or range, a small, black box called the fill handle appears in the lower, right corner of the selection. When the mouse pointer is positioned on the fill handle, it changes into a solid, black plus (+) sign. If the cell contains a label that Excel recognizes as an item in a standard series, you can drag the fill handle to extend or complete the series. As you drag, a ScreenTip displays the series label for each cell included in the series.

When you release the mouse button, Excel fills the series based on the contents of the first cell, and the **Auto Fill Options** button appears adjacent to the last cell in the series. Clicking the **Auto Fill Options** button displays a list of available Auto Fill options.

Auto Fill options include: **Copy Cells**, which copies the first cell to each cell in the series rather than filling it; **Fill Formatting Only**, which copies only the formatting of the first cell, not its contents; and **Fill Without Formatting**, which excludes the formatting of the first cell when filling the series. Other options may appear depending upon the text in the first cell.

---

- If Excel does not recognize the label in the first cell as part of a standard series, the cell contents are copied into the range instead.
- The **Auto Fill Options** button automatically closes when you perform another action, such as entering data or saving the workbook.

---

Procedures

1. Select the cell containing the starting label in the series.
2. Drag the fill handle at the bottom, right corner of the active cell as needed to select the series you want to fill.
3. Click the **Auto Fill Options** button.
4. Select the desired Auto Fill option.
WORKING WITH THE OPTIONS DIALOG BOX

Discussion

There are a variety of new settings available in the Options dialog box. The table below provides an overview of new pages and features:

<table>
<thead>
<tr>
<th>Options Page</th>
<th>Description of New Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>New options allow you to hide or display the task pane when starting Excel, as well as display multiple workbooks on the Windows taskbar.</td>
</tr>
<tr>
<td>Edit</td>
<td>New options include extending formats and formulas when you add items to the end of a list and displaying options buttons that appear when you paste or insert data. When the <strong>Enable automatic percent entry</strong> option is enabled, numbers less than 1 entered into cells formatted with a percent style are multiplied by 100. Numbers greater than 1 are not multiplied by 100. Therefore, entering either .05 or 5 into a cell formatted with a percent style results in 5%.</td>
</tr>
<tr>
<td>General</td>
<td>New options include displaying function tooltips and accessing the Web Options dialog box in order to select Web options.</td>
</tr>
<tr>
<td>International</td>
<td>The options on this new page allow you to specify both decimal and thousands separators, permit A4/letter paper resizing, change the default direction to read from right-to-left, change the direction for just the current sheet to read from right-to-left, define cursor movement, and show or hide bi-directional control characters.</td>
</tr>
<tr>
<td>Save</td>
<td>The options on this new page allow you to enable and configure the <strong>AutoRecover</strong> feature.</td>
</tr>
<tr>
<td>Error Checking</td>
<td>The options on this new page allow you to enable or disable background error checking, configure the error indicator, set error checking rules, and reset ignored errors.</td>
</tr>
<tr>
<td>Spelling</td>
<td>The options on this new page allow you to select a dictionary language, language-specific options, the custom dictionary, and spell check options, as well as access the AutoCorrect Options dialog box.</td>
</tr>
<tr>
<td>Security</td>
<td>The options on this new page allow you to set passwords for opening and sharing workbooks, recommend read-only status, select an encryption type, attach a digital signature, and set privacy and macro security options.</td>
</tr>
</tbody>
</table>
LESSON 4 -
USING NEW FORMATTING FEATURES

USING THE INSERT OPTIONS BUTTON

Discussion

When you insert one or more columns or rows into a worksheet, the Insert Options button appears to the right of the inserted column(s) or below the inserted row(s). Clicking the Insert Options button displays a list of available formatting options.

When inserting columns, you can choose to format the inserted column the same as either the column to the left or the column to the right, or you can clear all formatting. When inserting rows, you can choose to format the inserted rows the same as either the row above or the row below, or you can clear all formatting.

By default, the cells in an inserted column adopt the formatting of the cells in the column directly to the left, and the cells in an inserted row adopt the formatting of the cells in the row directly above.

Procedures

1. Right-click the column heading to the left of which you want to insert a column.
2. Select the Insert command.
3. Click the Insert Options button.
4. Select the desired option.
5. Right-click the row heading above which you want to insert a row.
6. Select the Insert command.
7. Click the Insert Options button.
8. Select the desired option.
SPLITTING CELLS

Discussion

The **Merge and Center** button on the **Formatting** toolbar is now a toggle. After cells in a worksheet have been merged and centered, you can use the **Merge and Center** button to split the merged cell back into the original, individual cells. This option is useful when you want to see how the worksheet would appear with a title centered above multiple columns, or if you inadvertently center and merge the wrong cells.

In addition, you no longer have to split a merged cell back to its original cells in order to insert or delete a column or row within the range of the merged cell. The merged cell automatically resizes to accommodate the inserted or deleted columns or rows.

Procedures

1. Select the merged cell you want to split.
2. Click the **Merge and Center** button.

DRAWING CELL BORDERS

Discussion

The **Borders** toolbar allows you to easily create cell borders by drawing them. You can draw borders around individual cells, around a range of cells, or diagonally through a cell. In addition, you can draw a top, side, or bottom border or any combination thereof. You can also erase borders, removing the entire border or only individual borders. You do not have to select a cell or range before drawing or erasing borders.

A variety of line widths, styles, and colors can be applied to borders. Applying different colors or line styles to cells or ranges can help differentiate or emphasize various sections of your worksheet. For example, you might want to border various sales regions in blue and then border the region with the highest sales figures in red. In addition, you can quickly draw a double-line border around one particular sales representative within a region.

When the **Draw Border** button on the **Borders** toolbar is activated, the mouse pointer displays a pencil. When the **Erase Border** button on the **Borders** toolbar is activated, the mouse pointer displays an eraser.
Procedures

1. Click the arrow on the **Borders** button.
2. Select the **Draw Borders** command.
3. Select the **Line Style** or **Line Color** list as desired.
4. Select the desired line style or line color option.
5. Select the arrow on the **Draw Border** button.
6. Select the desired draw border option.
7. Drag to select the cells to which you want to add the border.
8. Click the **Draw Border** button to deactivate it.
9. Click the **Erase Border** button.
10. Drag to select the cells from which you want to remove the border.
11. Click the **Erase Border** button.

**USING DISTRIBUTED ALIGNMENT**

Discussion

Excel now provides a new **Distributed** option for horizontally or vertically aligning text. When text is distributed, the words are spread equally to fill the cell. You can select a horizontal distribution to spread text across a cell in a very wide column or across merged cells that span multiple columns.
Conversely, you might select a vertical distribution to fill a cell in a row formatted for a large row height or to distribute text down merged cells that span multiple rows.

The name of the distributed alignment option in the **Horizontal** list is **Distributed (Indent)**, and the name in the **Vertical** list is **Distributed**.

**Procedures**

1. Select the cell containing the text you want to distribute.
2. Select the **Format** menu.
3. Select the **Cells** command.
4. Select the **Alignment** tab.
5. Select the **Horizontal** or **Vertical** list, as desired.
6. Select the corresponding **Distributed** option.
7. Select **OK**.

**PASTING FORMATS**

**Discussion**

You can use the **Paste Options** feature to quickly copy formatting from one cell to another. When you paste cut or copied cells, the **Paste Options** button appears adjacent to the paste range. Clicking the **Paste Options** button displays a list of available formatting options for the pasted cells.

You can paste the formatting from the copied cell to the contents of another cell or to a blank cell. When you paste formatting to a blank cell and then enter data, the data is automatically formatted accordingly.

The **Paste Options** button also allows you to apply the column widths of the copied cells to the pasted cells, thereby eliminating the need to manually adjust column widths.

You can also use the **Format Painter** button to copy and paste formats.

You can also use the **Paste Special** feature to copy and paste formats. Paste Special is available from the **Paste** button list on the **Standard** toolbar and from the **Edit** menu.
Procedures

1. Select the cells containing the formatting you want to copy.

2. Click the Copy button.

3. Select the upper, left cell of the paste range.

4. Click the Paste button.

5. Click the Paste Options button.

6. Select the Formatting Only option.

EXTENDING LIST FORMATS AND FORMULAS

Discussion

When you add new data to the next row in a list, Excel automatically applies the formatting and formulas from the previous row. Enabled by default, this feature can be disabled by deselecting the Extend list formats and formulas option on the Edit page in the Options dialog box.

To extend the formats and formulas to a new row in a list, the formats and formulas must exist in at least three of the preceding five rows of the list. Therefore, to take advantage of this time-saving feature, you must enter the first three rows of data, including the desired formulas and formats. As you enter the next new row of data, Excel will automatically extend the formatting and formulas as you type.

If you are using different formatting on alternate rows of a list, you must repeat one of the formats on at least three rows for Excel to extend the formats and formulas to a new row.

Procedures

1. Select the Tools menu.

2. Select the Options command.

3. Select the Edit tab.

4. Select the Extend list formats and formulas option, if necessary.
5. Select **OK**.

6. Select the first cell in the next row of a list in which formatting and formulas exist on at least three of the preceding five rows.

7. Type the desired data.

---

**COLORING WORKSHEET TABS**

### Discussion

Excel 2002 now includes the ability to add color to worksheet tabs. If color has been added to a worksheet tab, a horizontal line in the selected color appears below the worksheet name when the tab is selected; the entire sheet tab displays the selected color whenever the tab is not selected.

You can select single or multiple worksheets when adding color to worksheet tabs. For example, you may want to add the color red to all worksheets containing sales figures for the first quarter and add a different color for each of the second quarter worksheets.

You can also right-click a worksheet tab and select the **Tab Color** command from the shortcut menu to display the **Format Tab Color** palette.

### Procedures

1. Right-click on the worksheet tab to which you want to add a color.
2. Select **Tab Color**.
3. Select the desired color.
4. Select **OK**. Repeat for other worksheets, if desired.
LESSON 5 -
WORKING WITH FORMULAS AND FUNCTIONS

ENTERING FORMULAS

Discussion
When you create a formula, Excel 2002 visually identifies its references within the formula. As you type or select a reference, the cell address appears in a colored font within the formula, and a border in the same color, with squares at each corner, appears around each referenced cell or range. Excel uses a different color to identify each formula reference.

Procedures
1. Select the cell into which you want to enter a formula.
2. Type an equal sign (=) to begin the formula.
3. Enter the first reference.
4. Enter the first mathematical operator.
5. Enter the next reference.
6. Continue entering references and mathematical operators as needed.
7. When you have finished creating the formula, press [Enter].

USING THE AUTOSUM LIST

Discussion
The AutoSum button provides a list of commonly used functions you can perform on consecutively filled cells in a column or row. In addition to Sum, these functions include Average, Count, Max, and Min.

AutoSum automatically uses the cell range immediately adjacent to the active cell for the suggested range. If this suggested range is incorrect, you can drag to select the cells containing the values you want to calculate.
Another method of inserting a formula using the **AutoSum** list is to select the column or row of values, including the blank cell that is to contain the formula. When you then select a function from the **AutoSum** list, the formula is inserted without stopping to confirm the cell range.

The **More Functions** command in the **AutoSum** list opens the Insert Function dialog box, which can be used to access all Excel functions.

---

### Procedures

1. Select the cell into which you want to enter a formula.
2. Click the arrow on the **AutoSum** button.
3. Select the desired function.
4. Drag to select the range you want to calculate, if necessary.
5. Press `[Enter]`.

---

## INSERTING FUNCTIONS IN FORMULAS

### Discussion

If you are not sure of the proper syntax of a function, or if you need help entering a function into a formula, you can click the **Insert Function** button. The **Insert Function** button now appears on the formula bar and opens the Insert Function dialog box instead of the Paste Function dialog box.

The functions in the Insert Function dialog box are grouped by category. Selecting a category displays only the functions within that category. If you do not know the category of the desired function, you can select the **All** option to display all the available functions in alphabetical order. When you highlight a function, its syntax and description appear below the **Select a function** list.

After you have selected the desired function, the Function Arguments dialog box opens and displays an edit box for each argument in the function. You can enter a cell address, cell range, or numerical value for each argument into the corresponding edit box. An explanation of the selected function and an explanation of the selected argument appear below the list of edit boxes. As you fill in the arguments, the result of the formula appears below these explanations.

Each edit box contains a **Collapse Dialog** button, which can be clicked to collapse the Function Arguments dialog box to a title bar so that you can see the worksheet. You can then select the desired cell range, which will then appear in the collapsed edit box. After selecting the range in the worksheet, you can use the **Expand Dialog** button to redisplay the full dialog box.
You can access help by selecting the **Help on this function** hyperlink in either the Insert Function or the Function Arguments dialog box.

Typing an equal sign into a cell displays a **Functions** list to the left of the formula bar. This list stores the most recently used formulas. Selecting a function from this list opens the Function Arguments dialog box; selecting **More Functions** opens the Insert Functions dialog box.

You do not have to collapse the Function Arguments dialog box to select cells in the worksheet.

You can also type a description of exactly what you want to do in the **Search for a function** box and then click the **Go** button in the Insert Function dialog box.

**Procedures**

1. Select the cell into which you want to enter a formula.

2. Click the **Insert Function** button on the formula bar.

3. Select the desired category from the **Or select a category** list.

4. Select the desired function from the **Select a function** list.

5. Select **OK**.

6. Click the **Number 1** edit box **Collapse Dialog** button.

7. Drag to select the range you want to use in the calculation.

8. Click the **Expand Dialog** button.

9. Select **OK**.

**Using Function Tooltips**

**Discussion**

When you use a function, Excel 2002 now provides help in the form of a function tooltip. The tooltip displays the function syntax (i.e., the function name and the order of its required arguments). The function tooltip helps you keep track of the necessary arguments. When the function tooltip appears, the first argument is bolded. After you have entered the argument and typed a comma argument
separator, the next argument in the function tooltip is bolded. You can enter an argument by typing the argument text or by selecting the cell(s) containing the value for the argument.

Procedures

1. Select the cell into which you want to enter a function.
2. Type an equal sign (=) and the function name, followed by an open parenthesis.
3. Type the value or select the cell for the first argument.
4. Type a comma.
5. Type the value or select the cell for the next argument.
6. Type a comma.
7. Continue entering arguments and comma separators until the function is complete.
8. Press [Enter].

Using Date Functions

Discussion

When you enter a date into a cell, Excel formats it as a date, but stores it as the serial number that represents that date on the calendar. Excel treats dates as numbers so that it can perform calculations on them, such as determining how many days a bill is past due.

If you type a year between 1900 and 1929 as two digits, Excel assumes that the date is in the 21st century. Therefore, typing 2/13/25 returns the serial number for the date 2/13/2025. You must type all four digits to designate any years between 1900 and 1929.

Using Tooltips to Revise Functions

Discussion

You can use the function tooltip to revise a function. When you edit a function, its tooltip appears. You can use the tooltip to quickly select the argument you want to edit.

You can also use the Insert Function button on the formula bar to edit a function.
Procedures

1. Double-click the cell containing the formula you want to edit.
2. Click the argument you want to edit in the tooltip.
3. Revise the text as desired.
4. Press [Enter].

USING NARROW COLUMN TOOLTIPS

Discussion

When a column is too narrow to display the full value of the data in it, pound signs (#####) appear instead. Excel 2002 provides tooltips for narrow columns. When you point to any cell containing pound signs due to a narrow column, a tooltip displays the formatted cell value.
INDEX

Alignment
distributed, 19, 20

Ask a Question, 1

Auto Fill, 15

AutoSum, 23, 24

Borders
drawing, 18, 19

Cells
distributed alignment, 19, 20
drawing borders, 18, 19
extending list formats and formulas, 21
merging, 18
pasting formats, 20, 21
splitting, 18

Clipboard
pasting data, 13

Clipboard task pane
pasting data, 13

Columns
inserting, 17

Data
displaying in narrow columns, 27
extending list formats and formulas, 21
pasting, 11, 12, 13, 14
pasting a link, 13
pasting formats, 21

Date functions, 26

Document Recovery
pane, 8, 9

Excel 2002
new features, 1

Files
finding, 7, 8
recovering, 8, 9

Formulas
AutoSum, 24
creating, 23, 25, 26
revising, 26, 27
typing, 23

Functions
AutoSum, 23
date, 26
inserting into formulas, 24, 25
revising, 26, 27
tooltips, 25, 26

Help
Ask a Question, 1

Office Clipboard, 13
Options dialog box, 16
Paste Options
pasting formats, 20, 21
Paste Options button, 11, 12, 14
Pasting data, 11, 12, 13
Places Bar, 3
Ranges
    using Auto Fill, 15
Rows
    inserting, 17
Scroll bar
    shortcut menu, 11
Search
    basic, 7, 8
    finding files, 7, 8
    using the Basic Search task pane, 7, 8
Sheet tabs
    adding color, 22
Task panes, 1
    Advanced Search, 7
    Basic Search, 7
    Clipboard, 13
    navigating, 2
    New Workbook, 5, 6
    resizing, 2
    Search Results, 7
    selecting, 2
Templates
    creating workbooks from, 6
Workbooks
    creating from a template, 6
    opening, 3
Worksheets
    adding color to tabs, 22